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Learning Objectives 
 Learn how to create a completely fresh tool palette in a network location 

 Learn how to create, edit, and save tools onto your networked palettes 

 Learn how to boost productivity with scripts and macros hosted on your palettes 

 Learn how to hack your tool palettes without opening AutoCAD 

Description 
CAD standards are a bone of contention for every CAD manager. For me, CAD standards are all about a 
single thing - productivity. 

It's all about decision-making. I don't want you spending time deciding what font to use or what line 
weight to draw with. Those tasks don’t increase the project’s value. I want you to be able to focus on 
creating drawings that sell ideas to a client or help make manufacturing quicker and easier. You 
shouldn't need to worry about CAD standards. 

In this class I'll take you through the exact steps that I use to create a comprehensive set of tool palettes 
that deploy our company CAD standards. I'll show you how to deploy your tool palettes on the network, 
and how to update them from a central file. We will push as hard as we can into deploying scripts and 
macros from tool palettes, and cover some of the tips and hacks of tool palettes that you won't find in 
the help file. 

Your AU Experts 
Paul Munford is an Application Engineer for Graitec UK. Until recently 
Paul was a specialist joinery draughtsman (a “setter out”) and CAD/CAM 
manager for a U.K. based high-end custom furniture contractor. 

Paul had 8 years of experience “on the tools” before joining the CAD 
department in 2005. As an Application Engineer, Paul handles licensing, 
deployment, and training for AutoCAD software and Inventor software. 
Paul also uses AutoCAD and Inventor to create manufacturing 
“workshop” drawings for Graitec’s customers. 

In his spare time Paul writes the blog entitled CAD Setter Out, and he 
also authored Mastering Autodesk Inventor 2016. This will be Paul’s 8th 
trip to Autodesk University, and his 4th as a speaker. 

@Cadsetterout 

  

http://cadsetterout.com/
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This is all about CAD standards 
 

Don’t get me wrong. I am not one of those CAD managers who demand that all of our drawings are 
presented in the same way.  

I’ve heard people say; 

‘I don’t want to be able to tell who did this drawing until I look in 
the Title Box’ 

To which my response is – WHY? What is the advantage? How will this save the company money? 

Back in the old days BC (Before CAD), it was easy to tell who had created a drawing. Our handwriting, or 
even the way we drew our lines would give us away. 

Did this mean that our drawings didn’t communicate the information they contained effectively? No – of 
course not. 

To me – CAD standards aren’t about OCD. They are about Productivity. 

 

http://www.cadcartoons.com/ 
  

http://www.cadcartoons.com/
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Productivity and Decision fatigue 
There is a school of thought that each of us only has so much will 
power to spend on decision making in any given day. 

Did you ever wonder why Steve Jobs wore the same outfit every day? 
Did you know that Barak Obama eats the same meals – every day? 

This isn’t because they lack imagination or style. It is because they 
subscribe to the idea of Decision Fatigue. They don’t want to spend 
time thinking about these seemingly trivial decisions, when they have 
more important decisions to focus their willpower on.  

CAD standards make us more productive, because we don’t need to 
spend time making decisions about Line weights, font styles or 
standard symbols etc. Instead, we can spend our willpower on more 
important decisions. For example: 

 Can I use less material? 

 Can I reduce the number of parts? 

 Can I reduce machining time by making each part simpler? 

I personally don’t mind if people ‘stray’ from the CAD standard, as long as they can justify the time it 
took to do it, in terms of Increased Margin for the company. 

For Example: 

‘I was so worried about the site team missing this important order of fit note that I made it BOLD to 
emphasis it’ 

(This kind of derivation from the standard will not keep me awake at night). 

‘I love the comic sans font - because it is, like, so - groovy! So I made all the text on my drawing comic 
sans so that my drawing would look way cooler than everyone else’s’ 

(Is not acceptable in my office…) 

 

 

 

 

 

 

 

Further Reading - What makes a great CAD drawing? 
This is a question I ask frequently. I have collated the responses I’ve received in this post: 

http://cadsetterout.com/personal-posts/what-makes-a-great-cad-drawing/ 

Please feel free to add your own thoughts in the comments. 

http://cadsetterout.com/personal-posts/what-makes-a-great-cad-drawing/
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Objective: Compliance to the CAD standard 
The truth is, you can drop your 40 page CAD standard on that new hires desk – but they won’t read it! 

They certainly won’t spend any time working out how to make AutoCAD conform to the company 
standard. 

And what about those old hires that you inherited? How do you bring them up to date? 

In my experience, the easiest way to make people conform to a CAD standard, is to make it so easy to 
conform to the CAD standard that that they don’t even have to try. 

Our Objective is to make a set of tools that will help us maintain our CAD standard. Our tools should be: 

 Easy to set up 

 Easy to deploy 

 Easy to use 

 Easy to update 

 Easy to migrate to a new release of AutoCAD 

How to use standards in AutoCAD – the hard way. 
This is how standards traditionally work in AutoCAD from a user’s perspective... 

1. Think about what you’d like to draw. 
2. Refer to the CAD standard to see what Styles and Layers you should use. 
3. Make sure that you use the correct template file (That has the standard Styles and Layers in it). 
4. Set the Layer you need to work on. 
5. Set the style you need to use. 
6. Navigate to the tool you need to use. 
7. Draw the item. 

 

Is it any wonder that the users just skip steps 1-5 and just slap the geometry and annotations down any 
old how! 

If we want our users to comply with our standards, we have to make it easier than this. 

 

Why tool palettes? 
There are many ways we could achieve this objective. We could create custom MNU files, deployed via a 
company CUI or even create our own ribbon as a plugin using VB.net. 

I have tried out some of these options, and the time and effort it takes may be justified if you need to 
deploy your company standards over hundreds of seats and multiple locations. 

The reason I finally chose AutoCAD’s tool palettes for this task, is because they are just SO easy to set 
up. 

You won’t have to learn computer programming to create your company standard tool palettes, and you 
don’t need a qualification in IT to deploy them. 
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What we WON’T cover 
This tutorial is focused on creating and deploying tool palettes across a network, and is aimed at people 
who already have some familiarity with using Tool palettes and tool palette Tool creation. 

If you have never used tool pallets before, I highly recommend Matt Murphy’s class: 

GEN11407 - The Productivity Power of AutoCAD Tool Palettes—Revealed 

https://events.au.autodesk.com/connect/sessionDetail.ww?SESSION_ID=11407 

I DON’T cover AutoCAD verticals such as Architectural desktop and Civil 3D in this class. 

Planning and Preparation: What you will need before we start 
Before we start building our tools – do you have a CAD standard ready to deploy? I don’t want you to 
spend hours typing up a CAD standard if you don’t have one ready yet, but you do need to have made 
decisions on what it is you are deploying. 

CAD standards can usually be broken up into two main topics: 

Graphical standards 
This is what your printed output will look like. You will need to think about: 

 Line weights 

 Line types 

 Text styles 

 Dimension styles 

 Scales 

 Paper sizes 

 Title block and drawing borders 

I recommend that you create an AutoCAD file in which all these styles are defined. 

We will add this file to our resources folder later in the guide. 

Data standards 
This covers where you save your files, and how you manage them. You will need to think about: 

 Where to save your template files 

 Where to save your ‘Live’ CAD data 

 Where to save X-ref’s (or other linked data) 

 How you will manage revisions and versions of CAD data 

 Where you will save outputs – such as PDF or DWF 

 How you will manage revisions and versions of your output files. 

You will also need to decide where you want to store your deployed tool palettes. I recommend that you 
use a mapped drive (not a UNC path). 

Note: For the purposes of this exercise I will use U:\ to represent our mapped drive, you can use any 
letter that is free on your system. 

  

https://events.au.autodesk.com/connect/sessionDetail.ww?SESSION_ID=11407
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Windows XML Notepad 2007 
If you don’t have an XML editor on your computer, please download and install Windows XML notepad 
from: 

https://www.microsoft.com/en-gb/download/details.aspx?id=7973 

AutoCAD version 
I have been using this method of deploying tool palettes since 2012. In fact - the step by step process I 
outline in this presentation will work for any version of AutoCAD back to 2005 when tool palettes were 
introduced to AutoCAD, however – some options are not available in AutoCAD LT - I will do my best to 
highlight the differences as we go. 

Tip: If you want to work on your tool palette deployment from home, create the same mapped drive on 
your desktop or laptop. This will help file paths map correctly when you copy data back and forth 
between your local machine and your network. 

Setting up Folders for building your palettes 
Please set up two folders on your mapped drive - one will be for building palettes, one folder will be for 
deploying palettes. 

For example: 

U:\Deploy_2016 

U:\Build_2016 

Please set up a third folder for resources such as a PDF copy of your CAD standard and your DWG 
template files or block libraries. 

U:\Resources_2016 

Finally add a path for your own customisations. 

U:\Support_2016 

What is XML? 
XML is a software and hardware independent tool for storing and transporting data. 

XML is a markup language like HTML. A markup language is a set of tags (and a set of rules for creating 
tags) that can be embedded in digital text to provide additional information about the text. This helps to 
automate processing of the text, for example editing or formatting. 

XML stands for EXtensible Markup Language. Extensible means that you can add your own markup tags.  

https://www.microsoft.com/en-gb/download/details.aspx?id=7973
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Please include both the “Resources” and the “Support” folders to your support file search path by:  

1. Opening AutoCAD 
2. Opening a blank drawing 
3. Type OPTIONS at the command line and press the ENTER key 
4. Navigate to the ‘Files’ tab 
5. Expand the node for “Support File Search Path” 
6. Click on the yellow folder icon 
7. Click on ‘Add’ 
8. Click on ‘Browse’ 
9. Navigate to the “Resources_2016” 
10. Select the folder and click ‘OK’ 
11. Repeat for “Support_2016” 

Tip: I include the year in the folder title to help when it comes to migrating the company palettes. Each 
year I copy the folders and re-name them to suit the new version of AutoCAD. So far I haven’t had any 
issues migrating Tool Palettes between releases, but I feel much happier keeping them separate, just in 
case the new release break something! 

AutoCAD LT Tip: It is worth keeping this file path SHORT. You’ll see why later! 
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A Clean start 
The method I outline in this paper replies on using a completely clean template file, and then ‘Pulling’ 
the standards in that we need.  

The objective here is to minimize the amount of extraneous data (C*%p) that is in our final drawing file. 

Before we start, let’s make sure that AutoCAD has a default template set for the ‘New Drawing’ 
command QNEW. 

1. Start AutoCAD and open a blank new drawing. 
2. Open the ‘Options’ dialog by typing OPTIONS at the command line and press the ENTER (Return) 

key. 
3. Navigate to the Options dialogue > Files tab. 
4. Expand the browser node for – Template settings > Default File Name for QNEW 
5. Left Click on the file path 
6. Click the ‘Browse’ button in the top right of the Options dialogue. 
7. You will be taken to your template file location. 
8. Choose a template file to use for your new blank drawing. 
9. Click ‘Open’ in the ‘Select a File’ dialogue. 
10. Click ‘OK’ in the Options dialogue. 

What template file should I use? 
If you work in Feet and Inches (Imperial) measurements, use the acad.dwt file. 

If you work in metric use the acadiso.dwt file 

If you use AutoCAD LT these files may be named: 

acadlt.dwt and acadltiso.dwt. 

Managing tool palette locations using profiles 
Changes to AutoCAD tool palettes are only written out to disk (i.e. ‘Saved’) when you CLOSE AutoCAD. 
We will re-visit this through this tutorial, it’s important. 

This gives us an issue when we want to edit or update a tool palette. 

If I open AutoCAD up on my machine, and you open AutoCAD on yours. And we both load up the same 
tool palettes from a network location, then I update the tool palettes and shut down AutoCAD (writing 
out the changes) then YOU shut down AutoCAD after me – your tool palettes will overwrite mine. You 
will overwrite all the changes I just made. And I will get mad… 

So – we need to have a method for isolating our updated tool palettes (I call these the ‘Build’ set) from 
the Tool Palettes that are users are currently using (I call this the ‘Deploy’ set). We will also want to find 
a way of ‘Locking’ our Custom tool palettes so that our users can’t edit them by accident. 

The AutoCAD default Tool Palette location. 

By default, all AutoCAD tool palette files are saved in the following location: 

C:\Users\[USER NAME]\AppData\Roaming\Autodesk\AutoCAD 
2016\R20.1\enu\support\ToolPalette 
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You can check this in AutoCAD. Opening the options dialog by typing OPTIONS at the command line and 
pressing the RETURN key. 

Note: You will need to have a DWG file open in order to open the options window. 

Navigate to the ‘Files’ tab and scroll down to ‘Tool Palettes File Locations’. This is the path that we will 
use to edit the location where our new tool palettes will be created. 

Note: ‘Authoring Palette File Location’ is the location for the Block Authoring Palette used in the block 
editor. This is nothing to do with our custom tool palettes. 

To Creating a brand new ‘clean’ tool palette 
To edit the Default Tool Palette path, click on the path once to select it, and then click on the ‘Browse’ 
button to browse to your new location. Click OK to close the OPTIONS window. 

Tip: you can also slow click twice on the file path and then copy and paste the new path from Windows 
file explorer. 

Now close AutoCAD. Yes, that’s right CLOSE AutoCAD (Remember that closing AutoCAD ‘Saves’ changes 
to Palettes?). 

Now browse to your ‘Build folder’. You will notice that AutoCAD has created a new file called 
‘AcTpCatalog.atc’ and has created a new folder called ‘Palettes’. The Palettes folder will 
contain one file called (something similar to) ‘New Palette_8526A9CE-6881-4612-BEBC-
4E8950B51327.atc’. ‘New palette’ is the default name for any new palette and the long 
number is a unique identifier (GUID - globally unique identifier), this will change for each palette 
created. 

This is a brand new ‘Clean’ tool palette, with no tools created on it. 
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Introduction to a Tool Palette Catalogue (.atc) file 
Open ‘AcTpCatalog.atc’ with XML notepad. Expand the browser node for: 

Palettes > Palette > ItemID > idValue 

Palettes > Palette > URL > href 

Palettes > Palette > Properties > ItemName > Text 

So - an .atc file is a catalogue file that points to tool palette locations on the network.  

Close the .atc file 

 

  



AutoCAD Tool Palettes Master Class 

 
 11 

 

Introduction to a Tool Palette (.atc) file 
Open ‘New Palette_[GUID].atc’ with XML notepad. Expand the browser nodes for: 

Palette > ItemID > idValue 

Palette > Properties > ItemName > Text 

As you can see, AutoCAD uses the Tool Palette name and GUID to track tool palettes and their locations. 

Take note of the ‘Tools’ node, we will visit this later. 

Close XML Notepad 

 

 

 

In windows explorer copy the ‘Palettes’ folder and the AcTpCatalog.atc file from your ‘Build’ folder 
to your ‘Deploy’ folder. 
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Creating a CAD Admin ‘Build’ profile (Not available in AutoCAD LT). 
In order to manipulate the tool palette file path easily, we will create a new profile that points to this 
location. In fact, we will create two. One for your regular users, and one for you. 

Open AutoCAD, and open the OPTIONS window. Now navigate to the ‘Profiles’ tab. 

On the profiles tab create a new Profile: 

1. Click ‘Add to List…’ 
2. In the ‘Add Profile’ Window > ‘Profile name:’ text entry box, type ‘CAD Admin’ (without the 

quotes). 
3. Click ‘Apply and Close’. 
4. Click on ‘CAD Admin’ 
5. Click on ‘Set Current’ 

You have created a new user profile called ‘CAD Admin’. Make sure that the tool palette path looks for 
its tool palettes in: 

U:\Build_2016 

Creating a CAD User ‘Deploy’ profile (Not available in AutoCAD LT). 
Now navigate back to the ‘Profiles’ tab and create a new profile for your users: 

1. Click ‘Add to List…’ 
2. In the ‘Add Profile’ Window > ‘Profile name:’ text entry box, type ‘CAD User’ (without the 

quotes). 
3. Click ‘Apply and Close’. 
4. Click on ‘CAD Admin’ 
5. Click on ‘Set Current’ 

Navigate back to the OPTIONS > Files tab, and change the ‘Tool Palettes File Locations’ to your Deploy 
folder. In my case the path is: 

U:\Deploy_2016 
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Changing the Tool Palette path using profiles 
You can now toggle the active tool palette path by navigating to the OPTIONS > Profiles tab and double 
clicking on a profile to make it active. 

Notice that the active User Profile is shown at the top of the window. Toggle back and forth a few times 
and check that the path is changing from our Build folder to our Deploy folder. 

When you are happy that it is working correctly, close the Options window. 

Changing the Tool Palette Path in AutoCAD LT 
If you are using AutoCAD LT, you will have to swap these paths manually (Or hack the registry!). 

Tip: The AutoCAD System variable: 

*_toolpalettepath 

Controls the current path to the Tool Palette folder. You can type the new path at the command line. 
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Locking your deployment set of palettes 
Navigate to New Palette_[GUID].atc, click on it to select it, right click on it and chose ‘properties’, 
then check the read only attribute. 

Toggle back to ‘CAD Admin’ profile, then back to ‘CAD User’ profile to reload the Palette from the 
Deploy_2016 folder back into AutoCAD. 

You will notice that the palette loaded from the Deploy_2016 folder has a little padlock icon in the lower 
corner.  

This makes this singular Tool Palette read only to your Users. The users will be able to edit the tools on 
the palette from within AutoCAD, but the changes won’t be written out to disk when AutoCAD closes. 

Note: Only lock the Tool Pallette .atc files themselves, don’t lock the Cataloge .atc file and don’t lock the 
whole folder. AutoCAD will complain if it doesn’t have read/write access to these file locations. 
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Creating brand new tool palettes on the network drive 

To start creating your new tool palettes, Open AutoCAD with a blank drawing open and set your profile 
back to ‘CAD Admin’.  

At this point you will need to plan your palettes to suit your department, industry or organisation. 

For example: 

 Standards 

 Library 

 Draw 

 Hatch 

 Annotate 

 Layouts 

 Viewports 

 Markups 

To create a new palette, right click anywhere on an existing palette and select ‘New palette’. 

To rename a palette, right click over an existing palette and chose ‘Rename palette’. 

(If you are following this tutorial step by step - create these palettes now).  

Tip: Right click on any Palette and choose ‘Customise Palettes’ to bring up a dialog that will allow you to 
quickly add, delete re-name and re-order your palettes. 

Save your palettes 
Shut down AutoCAD when you are done to write the changes out to disk! 

Now browse to your Build Folder. 

Open the ‘ACTpCatalog.atc’ file again with XML notepad. 

You should see that a number of nodes have now been added to the ‘palettes’ section - one for each 
palette we created in AutoCAD. If you expand the nodes you will see the palette name, and a GUID. 

Now go back to windows and browse to: 

U:\Build_2016\Palettes 

You will notice that a new .atc file has been created for each palette, and that each palettes name is 
made up of the palette name that you chose and the GUID allocated by AutoCAD eg. 

STANDARDS_387A1556-3B4E-4848-A54A-A7A3C9AEB73F.atc 
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Creating tools from your standard objects 
At the beginning of the handout I set the assumption that you were familiar with toolpallettes. I am 
expecting that you know how to move, dock, rollup toolpallettes, change the view options and create 
simple tools. 

However just in case you haven’t covered tool creation before I will give a brief explanation here: 

1. To create a Tool palette Tool from AutoCAD geometry (Lines, arcs, hatches) 
2. Open AutoCAD (make sure that you are using the CAD Admin profile). 
3. Open your ‘Global’ template file (the template you have created all your standard styles in) 
4. Open your tool palettes and navigate to the palette you want to add a tool to. 
5. In your AutoCAD drawing file, click and drag an item from the drawing onto the Tool palette. 

The tool created will depend on the type of item you dragged and dropped onto your tool palette.  

Dragging a Line onto a tool palette will create a line tool, dragging a hatch will create a hatch tool. 

Once you have created a tool, right click on it to see its properties. You will notice that the tool has 
retained information from the object, such as its layer.  

Now this layer/style information has been defined in the tool palette – you don’t have to have it in your 
template file… 

Every time you use this tool – the company standard layer will be defined in the .DWG you have open – 
weather it originally existed in the DWG file or not! 

This is the power of tool palettes for standardization. 

You can quickly and easily create a tool that will define its own standards when it is used. 

Give that some thought. 

If you create a set of tool palettes that are easier to use than the standard AutoCAD commands – why 
wouldn’t your users use them! 
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Styling Your Tool Palette 
You may feel that your new tools look a little dull. 

To edit the properties of a Tool Palette tool button, right click on the button. 

You can now edit the button name, give it a description (This will show up as a tool tip when you hover 
over it) and right click on the Icon to change the Icon Image. 

You can style the tool palette itself by right clicking anywhere on the tool palette itself and choosing 
‘Add Text’ or ‘Add separator’.  

I like to use text to describe what each palette is for, and what each button does (We can’t make it too 
obvious!). 

I also like to add some text to the first palette with a Build number - so that I have a quick visual clue to 
which build of the tool palettes a user has loaded. This is particularly helpful if a user is located away 
from the network server, and may not be picking up updates. 

Notes on Button Images 
When you replace a button image, AutoCAD will create a new Folder in your palettes folder, called 
‘Images’ eg. 

U:\Build_2016\Palettes\Images 

AutoCAD will copy your bespoke image here and create its own copies at the correct size for its own use. 
The standard image size is 64 x 64 PX at 96 DPI and .PNG files with a transparent background (Alpha 
channel) will work in AutoCAD 2016 (previous versions may require that you sample the back ground 
colour of the palette in order to get the button background to match). 
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Tool Order ‘Copy and paste’ hot tip 
I’ve noticed that when you re-order tools on the palette, AutoCAD doesn’t always respect this when it 
writes the files out. Instead AutoCAD will right the tools out in the order you created them. 

This means that, when you open AutoCAD again, your tools will all be in the wrong order! (Has this 
happened to you?) 

To fix this, I’d like you to hover over your palette, left mouse click once anywhere on the palette itself to 
makes sure that you don’t have anything selected, then use the CTRL+A on your keyboard to select all 
the tools, text and separators you just created (You can also left click and drag a crossing window if you 
prefer). 

Now CTRL+X (Cut) and then CTRL+V (paste) all the tools back onto your palette. 

Why did we just do this? 

Cutting and pasting the tools back in forces AutoCAD to order the tools in the right order. Do this before 
you close AutoCAD to save your changes to the palettes you are working on. 

Close AutoCAD to save changes 
Don’t forget to close AutoCAD to save your changes. 
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Digging into a Tool Palette .atc file  
With AutoCAD closed, open: 

U:\Build_2016\Palettes\Standards_[GUID].atc 

With Windows XML Notepad. 

Expand the Palette > Tools > Tool > Properties node, and examine the values under ‘Item name’ and 
‘description’. 

Next expand the ... Tool > Data > Command > Macro node to check its value. 

You should now have a good idea of what is going on inside the XML .ATC files that make up the Tool 
Palettes catalogue and The Tool Palettes themselves. 
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Creating a deployment set 

Remember that AutoCAD writes out the changes to tool palettes on save? 

Remember the difficulty this causes? 

If multiple people are referencing the same set of tool palettes concurrently, the last person to close 
AutoCAD will ‘win’. The copies of the Tool palettes files that their installation of AutoCAD has loaded 
into memory will be written out to file, over writing any changes you have made. 

To get around this, we need to create a separate set of tool palettes that will be for deployment only. 

To do this copy and paste the contents of: 

U:\Build_2016 

Into 

U:\Deploy_2016 

You will load this set into tool palettes into AutoCAD for your users – keeping your ‘Build’ set for your 
own use only. 

The final step is to ‘Lock’ your deployment set of palettes so that they can’t be edited. 

Locking Tool Palettes for edit. 
Navigate to the palette files in your Deployment folder e.g. 

U:\Deploy_2016\Palettes\New Palette_A7CD139E-87D9-4113-8581-2CE76F09A31B.atc 

 Click on each Palette file it to select it, then right click on it and chose ‘properties’. Now check the read 
only attribute. 

Tip: This will make each singular Tool Palette read only to your Users. The users will be able to edit the 
tools on the palette from within AutoCAD, but the changes won’t be written out to disk when AutoCAD 
closes. 
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Deploying your tool palettes 
We now have a set of tool palettes ready to be used by our users (Woot!). 

We have a number of options when it comes to deployment. 

We could: 

 Go to each machine and add the support file and tool palette paths from the options dialogue 
individually (AutoCAD LT users stop reading here). 

 Go to each machine and load in the ‘CAD User’ profile. 

 Something else…  

There is a way of changing the paths in the options dialogue using a single file which can control all of 
your users AutoCAD installations from a single network location. It still requires that you add a file to 
each install of AutoCAD, but once you have this set up – you will never need to visit each individual 
machine again. 

The ACAD.lsp file 
Every installation of AutoCAD will look for a file called ‘ACAD.lsp’ on start-up. If it finds it, it will run 
whatever code is contained within the file. 

We will use the ACAD.lsp file to run an Initialisation file. It is the initialisation file which can be located 
centrally on our network. 

Once we’ve pointed the ACAD.lsp file at the Initialisation file, we can edit the initialisation file at any 
time and it will be loaded into memory the next time our users fire up AutoCAD. 

This gives you a HUGE amount of control! (Remember that with great power comes great 
responsibility!). 

This ACAD.lsp is an AutoCAD LISP (List processing language) file which you create. Typically you would 
save it in the users AutoCAD support path, e.g. 

C:\Users\[User Name]\AppData\Roaming\Autodesk\AutoCAD 2016\R20.1\enu\Support 

To create an ACAD.lsp file. 
To create an ACAD.lsp file, create a new Windows notepad document. Save the Document as ACAD.lsp 
(You can ignore the windows warning about changing file extensions). 

Now re-open the ACAD.lsp file with notepad and add the following code: 

(setq lisp_path “U:\\Support_2016”) ; sets the path 

(if (findfile (strcat lisp_path "init.lsp")) ;If you can find a file called 
‘init.lsp’ 

(load (strcat lisp_path "init.lsp")) ) ;Load the file called ‘init.lsp’ 
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Trusted locations 
To prevent the unscrupulous using this workflow to install a virus into AutoCAD, Autodesk created the 
concept of trusted locations. 

The first time you start AutoCAD you will get a message asking if you trust ‘ACAD.lsp’. 

Check the ‘Always load this application’ box, and click the ‘Load’ button. 

Tip: If you are not worried about security you can turn this feature off by setting the ‘SECURELOAD’ 
system variable to 0 

Adding a support file location to the trusted locations 
1. Open the AutoCAD Options dialogue 
2. Expand the browser node for ‘Trusted Locations’ 
3. Click next to the arrow 
4. Click the ‘Browse’ button 
5. Navigate to ‘U:\Support_2016’ 
6. Click ‘Continue’ in the ‘Trusted File Search Path – Security Concern’ dialogue. 
7. Click OK to close the options dialogue. 

To create an init.lsp file 
Our Automated deployment strategy has two components. The ACAD.lsp file that sits in the user’s local 
support file search path, and our init.lsp file that sits on the server. The ACAD.lsp file loads the init.lsp 
file. 

To create the init.lsp file: 

1. Navigate to ‘U:\Support_2016’ 
2. Right click and create a new text file. 
3. Save it as init.lsp 
4. Ignore the warning from windows about changing file extensions. 

What to put in your Init.lsp? 
You can use your init.lsp to set any AutoCAD system variable. We will use the Init.lsp file to load in our 
‘CAD User’ profile. 

1. Export your CAD User Profile 
2. Open the AutoCAD options dialogue 
3. Navigate to the ‘Profiles’ tab 
4. Left click to select ‘CAD User’ 
5. Click the ‘Export’ button 
6. Save the .arg file as ‘CAD_User’ in your ‘Support_2016’ folder. 
7. Click OK to close the Options dialogue. 

U:\Support_2016\CAD_User.arg 

Now we will add the lisp code to the init.lsp file to load this profile on start-up. 

Open init.lsp using the windows text editor and past in the following code: 
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;Load Visual Lisp 

(vl-load-com) 

 

;Import the "CAD_User" Profile from the network 

(vl-catch-all-apply 'vla-importprofile (list 

    (vla-get-profiles (vla-get-preferences (vlax-get-acad-object))) 

    "CAD User" 

    "U:\\Support_2016\\CAD_User.arg" 

    1) 

     ) 

 

;Set "CAD_User" Profile current 

(vla-put-ActiveProfile (vla-get-Profiles (vla-get-Preferences (vlax-get-acad-
object)))"CAD User") 

 

;Set the "modemacro" sysvar to report the latest profile 

(SETVAR "modemacro"(STRCAT "PROFILE: $(getvar, cprofile)")) 

 

Notes on Init Lisp 
The code in the block above uses LISP code to import and load the “CAD_User.arg” profile from the 
network, and set it active. 

In addition, it will set the “modemacro” value to equal the current user profile, which gives you some 
nice feedback that this has worked. 
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What would you do with the init Lisp? 
Let’s just put profiles and tool palettes aside for one moment… 

The init.lsp file can now be used to set any AutoCAD system variable on startup… 

Think about that… 

Do you have a user who always seems to turn FILEDIA off? – set it in the init.lsp 

Would you like to turn off the ‘Trusted paths warning? – set ‘SECURELOAD’ to 0 in the init.lsp. 

Would you like to load your own customizations into AutoCAD for all your users? – set it in the init.lsp 

In fact, you don’t need to set the profile with the init.lsp as all – you can set each of the paths in the 
Options dialog separately, retaining control of the system paths but allowing the users to maintain their 
own profiles. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

What else can we do with the Init.lsp? 
If you’d like to know more about this powerful method of standardizing AutoCAD across your network, 
check out R.K McSwain’s class: 

IT9952 - Deployments and AutoLISP: Strategies for Easy Installations and Maintenance 

https://events.au.autodesk.com/connect/sessionDetail.ww?SESSION_ID=9952&tclass=popup 

 

  

https://events.au.autodesk.com/connect/sessionDetail.ww?SESSION_ID=9952&tclass=popup
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Profiles and Tool Palette Groups 
So – why did we set the profile in the Init.lsp? 

It seems strange (At least it seems strange to me!) but Tool palette groups are stored in the user profile. 
The standard way to share tool palette groups is to export them as an .XPG file and then import them to 
the new machine… but we don’t want to have to attend each machine! 

If you are good at coding, it may help you to know that AutoCAD stores its user profiles as .ARG files in: 

C:\Users\[User]\AppData\Roaming\Autodesk\AutoCAD 
2016\R20.1\enu\Support\Profiles 

When you switch profiles, AutoCAD takes the information from this file and writes it into the windows 
registry. 

You can open a profile .arg file with XML notepad, and see where the Tool palette groups are stored – so 
if you are really good at programming, you might be able to import and export this data to the users 
profile without have to attend their machine (Let me know if you work that one out!). 
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Profiles and AutoCAD LT 
AutoCAD LT doesn’t use profiles, but it does still write values to the registry in the same way as 
AutoCAD. You can copy the Registry values from your machine, and use them to set up your colleague’s 
machines. 

Statutory Warning – Messing with the registry can break AutoCAD and Windows 

Export a copy of the AutoCAD registry key: 

1. Hit WINDOWS-R on the keyboard to bring up the Run window, enter REGEDIT and click OK. 

2. Find the following registry key: 
 
HKEY_CURRENT_USER\Software\Autodesk\AutoCAD LT\Rxx.x\ACADLT-xxxx:40x 
 
This path is unique for each version of AutoCAD. You can see which 'ACAD-xxxx' refers to by 
selecting it and then looking at the keys on the right side of the Registry Editor. One of the keys 
will show the install path to the AutoCAD it applies to. The '40x' number signifies the language 
version of AutoCAD. 

3. Right-click the 'ACADLT-xxxx:40x' folder and choose Export. 

4. Enter a file name of your choice, choose a location to save the file, and then click Save. 

5. Close the Registry Editor. 

To Merge (Import) the AutoCAD 

1. Browse to where you saved the reg file. 
2. Right click the file and select Merge. 
3. Click “Yes” on the warning. 

Problems caused by improperly editing the Windows registry could render your computer operating system 
unusable. Microsoft provides a wealth of critical information that you need to know about the registry in the 
Microsoft Knowledge Base. Use the Microsoft Registry Editor only at your own risk and only after backing up the 
registry as outlined for your operating system in the Microsoft article How to back up and restore the registry in 
Windows and in the related solution How to backup the system registry. Additional information about the registry 
is also contained in the Help topics in the Microsoft Registry Editor. 

An alternative to Tool Palette Groups 
If you want to manage multiple sets of tool palettes and you don’t want to mess around with groups, 
you could try using multiple tool palette locations instead. 

The trick is to create a menu item, command or button macro that switches the Tool Pallet path to a 
new location. Here’s an example of a button macro that would do that: 

^C^C*_toolpalettepath;"U:/Arch_2016"; 
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Updating tool palettes 
Once you have the system set up, updating your tool palettes is straight forward. 

1. Open AutoCAD (make sure that you have the CAD Admin profile current). 
2. Edit your tool palettes (Create new palettes, create new tools, edit tools .etc) 
3. Use the Copy and Paste Tip to make sure that your tools get written out on your palettes in the 

right order. 
4. Close AutoCAD to save the changes. 
5. Copy and paste the contents of: 

U:\Build_2016 

Into 

U:\Deploy_2016 

6. Remember to lock your palette files. 
 

The job is done, the next time your users open AutoCAD, the new set of palettes will be available. 
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Creating and deploying Tool palettes checklist 
Here’s the complete steps from start to finish 

1. Set up a mapped drive on the network 
2. Create folders 
3. Create a new CAD administrator profile in AutoCAD 

A. Set the following paths: 
1. QNEW 
2. TOOLPALETTEPATH 
3. Add your resources folders to support paths 

4. Create your tool palettes 
5. Create your tools 
6. Copy and paste to make sure that things are in the right order 
7. Close AutoCAD to write out the changes 
8. Repeat steps 5-8 until you have your full set of palettes 
9. Copy and paste palettes from the Build folder to the Deploy folder 
10. Lock the deployment set of palettes 
11. Create a new profile for CAD users 

A. Set the following paths: 
1. QNEW 
2. TOOLPALETTEPATH 
3. Add your resources folders to support paths 

12. Deploy the tool palettes using the CAD user profile 
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Conclusion 
At the beginning of this document we asked for a solution to maintaining standards that met the 
following criteria:  

 Easy to set up 

 Easy to deploy 

 Easy to use 

 Easy to update 

 Easy to migrate to a new release of AutoCAD 

How do you think we did? 

I have tried to be as detailed as possible in my explanation, so it may seems like there are lots of steps – 
but none of the steps are complicated and once you have the system in place, it takes very little effort to 
maintain. 

Your Tool Palette deployment 
So let me know how you get on with YOUR tool palette deployment. 

 How has it helped you? 

 How has it helped your users? 

 What innovative ways have you found to use Tool Palettes to deploy your company standards? 

Thank you very much for your tome 

Paul Munford 

Paul@Cadsetterout.com 

 
 

Resources 
Here are some links to articles on the internet that you might also find useful: 

Setting “Modemacro” to report information at the status line 

http://www.cad-notes.com/how-to-use-the-autocad-status-line-to-provide-real-time-reporting/ 

Setting AutoCAD User Profiles with Lisp: 

http://jtbworld.com/autocad-profiles-lsp 

http://www.afralisp.net/visual-lisp/tutorials/profile-utilities.php 

You know when you search for something on line, and you end up finding one of your own comments 
on a forum? Yeah – that (This forum thread includes a link the AECedge article by Anthony Mason that 
helped me to formulate this system) 

http://forums.augi.com/showthread.php?138781-What-s-the-best-way-to-share-tool-palettes 

 

  

mailto:Paul@Cadsetterout.com
http://www.cad-notes.com/how-to-use-the-autocad-status-line-to-provide-real-time-reporting/
http://jtbworld.com/autocad-profiles-lsp
http://www.afralisp.net/visual-lisp/tutorials/profile-utilities.php
http://forums.augi.com/showthread.php?138781-What-s-the-best-way-to-share-tool-palettes
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Advanced tool creation 

Opening a PDF from a Tool Palette Tool 
The first tool we will create will be a shortcut to open up our CAD standards PDF from our tool palettes. 

Open AutoCAD, making sure that you have your ‘CAD Admin’ profile active. 

1. Navigate to your ‘Standards’ Tool Palette. 
2. Right click over the palette and choose ‘Customize commands’. 
3. In the ‘Search Commands’ field, type script. 
4. Drag and drop the Script command from the Customize Commands dialog, onto your palette. 
5. Close the Customize commands dialog. And right click on your new tool to choose ‘properties’. 

Adding a custom macro to a tool: 

We will now add a macro to this button to open or CAD standards PDF. 

To add the macro, right click on the tool and choose ‘Properties’. 

No add the following text to the ‘Command String’ field: 

^C^C_.browser;"U:/Resources_2016/CAD_Standard.pdf"; 

When you are done, click ‘OK’ to close the Tool properties window and click on the button to try it out. If 
we’ve got this right, your default web browser will now open your ‘CAD_Standards PDF’. 

Now, no-one has the excuse that they don’t have a copy of the CAD standard, it is only a click away! 

Macro Notes 
^C = the same as pressing the ‘Escape’ key on your keyboard 

^C^C = Escape twice, which is usually enough to close any command AutoCAD usually has running 
before running our Macro. 

_ =Use the English (American) version of the command - this gets around localized versions of 
AutoCAD that may be using another language 

. = ‘Undefine override’ - just in case some joker has undefined the ‘browser’ command 

browser = Opens your default web browser 

; = The same as pressing ‘Return’ (Enter) on your keyboard 

“URL” = The file path. Must be within quotes “ “, must not contain spaces, Windows Back slashes in 
the file path must become forward slashes in AutoCAD. 

 U:/Resources_2016/CAD_Standard.pdf NO 

 "U:\Resources_2016\CAD_Standard.pdf" NO 

 "U:/Resources 2016/CAD Standard.pdf" NO 

 "U:/Resources_2016/CAD_Standard.pdf" YES! 

; = Enter - to complete the command. 
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Further Reading - How to Automate AutoCAD with command Macros 
A command macro file is a list of commands for AutoCAD to follow all in one go. If you can type it at the 
command line, you can turn it into a Macro. 

Macro’s exist within a tool button’s command and can be deployed from Tool palettes, Menus and 
ribbon buttons (for example). Unlike LISP or VB.net, Macro’s will work with AutoCAD LT. 

Here is a link to an article I wrote for Edwin Prakoso’s ‘CAD-Notes’ blog on writing Macros for AutoCAD. 

http://www.cad-notes.com/how-to-automate-autocad-with-command-macros/ 

Opening a DWG from a Tool palette tool (button) 
We would like to add a button to open our Global DWG template file from our Standards palette, to 
allow our users to copy and paste standard content into their current drawing. 

Unfortunately, we can’t do this with a Macro. But we can do it with a Script, and we can call a script 
from a Macro, so we’ll do it that way.  

To create the script file: 

1. In Windows, Navigate to U:\Resources_2016 
2. Create a new text file. 
3. Rename the text file ‘open_global_template.scr’ 
4. (Ignore the warning from windows about changing the file extension). 
5. Open the file using the Windows text editor and add the following lines of text: 

open 

"U:/Resources_2016/Global Template.dwg" 

y 

Script Notes 
open = Run the AutoCAD ‘Open’ Command. 

Carriage return (New line)  = The same  as pressing ‘Return’ (Enter) on the keyboard. 

“URL” = The file path. Must be within quotes “ “, can contain spaces, 
Windows Back slashes in the file path must become forward slashes 
in AutoCAD. 

 U:/ Resources_2016/Global Template.dwg NO 

 "U:\ Resources_2016\Global Template.dwg" NO 

 "U:/ Resources_2016/Global Template.dwg" YES! 

Carriage return (New line)  = the same as pressing ‘Return’ (Enter) on the keyboard. 

 

Save and close the .scr file and then test it by dragging a dropping it into the AutoCAD graphics window. 

It works? Great! 

http://www.cad-notes.com/how-to-automate-autocad-with-command-macros/


AutoCAD Tool Palettes Master Class 

 
 32 

 

Now add a new button to your Tool palette just as before, and edit the command macro to open our 
Script file: 

^C^CSCRIPT;"open_global_template.scr" 

As before, this will run the ‘Escape’ command twice, to get us out of any active commands that AutoCAD 
is running, then it will run the ‘Script’ command, which will load a script file (.SCR) into AutoCAD, and 
finally we pass it the location of the script file we want to run. 

Further Reading - Learn how to write command scripts for AutoCAD and automate your plotting 
Like a command macro - a script file is simply a list of commands for AutoCAD to follow all in one go. 
Scripts are easy to create and are super handy for automating a process. If you can type it at the 
command line, you can turn it into a script. 

Like Macro’s scripts will work with AutoCAD LT. Unlike Macro’s, scripts are store in text files outside of 
AutoCAD. 

 Here is a link to an article I wrote for Edwin Prakoso’s ‘CAD-Notes’ blog on writing scripts for AutoCAD. 

http://www.cad-notes.com/learn-how-to-write-command-scripts-for-autocad-and-automate-your-
plotting/ 

The articles goes through the process step by step, explaining how recognise and record the steps for 
your script and write them out to a .SCR file. 

Opening a DWG in Design Centre 
Another option for allowing Users to grab standard content from a DWG file is via content centre. In the 
next section we will create a new tool palette button which will open the design centre palette (If it isn’t 
open already’ with our Global_Template.DWG file active. 

This allows our users to ‘drag and drop’ styles and standard content into their current drawing from 
Design centre (And may encourage them just to bring through what the need, rather than copy and 
paste everything from the Global Template file!). 

1. Create  a new Tool Palette Tool Button 
2. Edit the Button properties 
3. Add the following code: 

^C^C_adcenter;_ADCNAVIGATE;”U:/Resources_2016/Global Template.dwg”;  

Macro Notes 
_adcenter;  = This opens the Design Centre palette from the command line. The underscore 

uses the default English language version of the command (In case localization 
has been applied). The semi-colon is equivalent to pressing RETURN (Enter) on 
your keyboard. 

_ADCNAVIGATE; = Asks the Design center to navigate to a specific DWG file 

URL   = Don’t forget to swap the back slashes to forward slashes. 

http://www.cad-notes.com/learn-how-to-write-command-scripts-for-autocad-and-automate-your-plotting/
http://www.cad-notes.com/learn-how-to-write-command-scripts-for-autocad-and-automate-your-plotting/
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AutoCAD Block library Video tutorial 
This is a particularly powerful way of distributing AutoCAD Bocks. You can have a .DWG file containing 
many AutoCAD blocks (A Block Library) and the use tool palette buttons macro’s to toggle between 
libraries. 

Kevin McWhirter has an excellent Video tutorial that you can watch for more details. 

http://www.archblocks.com/archblocks-cad-blocks-how-it-works 

Importing Page set ups 
The final script that I like to have handy in my ’standards’ palette is a tool to import our company 
standard page set ups. 

Of course - our company standard template files already have this information in, but occasionally we 
have to plot drawings that we have received from outside the company that don’t have page set ups for 
our plotters. 

The ‘Import page set ups’ button allows us to import our standard page setups with a click, which we 
can then use for batch plotting. 

1. Create a new button on the Standards palette 
2. Edit the button properties 
3. Add the following code: 

C^C.-PSETUPIN;”U:/Resources_2016/Global Template.dwg”;"*" 

Macro Notes 
.-PSETUPIN; = Imports page setups from a DWG file. The underscore uses the default 

English language version of the command (Incase localization as been applied). 
The semi -colon is equivalent to pressing ‘Return’ (Enter) on your keyboard. 

http://www.archblocks.com/archblocks-cad-blocks-how-it-works

